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Introduction 

IBackup for Mac is a user friendly, secure and reliable online backup and restore application. It lets 
you perform interactive backups/restore and schedule backup of your files/folders for a later date 
and time. Data is transferred and stored using 256-bit AES encryption.  

The graphical user interface makes it an easy-to-use application. IBackup for Mac safeguards your 
critical data in case of a system crash.  

The other key features include data compression during file transfer that ensures quick backups, 
Incremental backups that preserve bandwidth and versioning to restore 30 previous versions of all 
backed up files.  
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Features 
 
The features can be summarized as follows: 
 
General Features 

 256-bit AES encryption during data transmission and storage that ensures secure online 
backups 

 Compressed data during transmission that speeds up your backups 
 Incremental backups where only the modified portions of your files are backed up to your 

account, thus conserving bandwidth 
 Easy selection of your files/folders for backup 
 Performs interactive backup/restore or schedule backup for a future date and time 
 Provision to receive email and desktop notifications after every scheduled backup job 
 Web-based access to backup and restore your files as also to view and search for them 

and to retrieve log reports 
 Locate files and folders and restore them on your Mac desktop. 
 Automatic backup of commonly backed up folders including Desktop, Documents, Music, 

Movies and Pictures 
 Share files and folders from your account 
 Bandwidth Throttle allows you to control your Internet bandwidth usage 
 Upgrade to the latest version using the 'Software update' feature 
 'Automatic Power off' option after scheduled backup - the machine shuts down 

automatically once data is backed up 
 Sync data in your online account with that on your Mac 

 
Backup Features 
 

 Mirror Path ensures that the file-folder hierarchy on your local Mac is replicated in your 
IBackup for Mac account 

 Drag-n-drop files/folders from your Mac machine to IBackup for Mac account for backup 
 Schedule Backup configuration allows you to customize the scheduled backups as per 

your convenience (based on date, time or frequency) 
 Efficient Storage Computation that ensures that the total storage space is calculated only 

for the latest version of a particular file and is not based on its previous versions 
 Manage all the scheduled backup jobs enables you to manage all your scheduled 

backup jobs with the click of a button 
 Backup your Mapped and Network drives 
 Scheduled backup in system lock/logoff mode ensures that your scheduled backup 

takes place uninterrupted. Further, there is a provision to automatically shut down the Mac 
on completion of the operation. 

 Backup data from multiple computers to a single account 
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Restore Features 
 

 Interactive Restore that allows you to immediately restore files/folders from your IBackup 
for Mac account to the local Mac. 

 Drag-n-drop files/folders to restore from your IBackup for Mac account to your Mac 
machine 

 Versioning – provision to retain and restore 30 previous versions of files backed up to your 
IBackup account. 

 Trash - option to retrieve deleted files from your IBackup account within a period of 30 
days. 

 
 

Note: Refer http://www.ibackup.com/old-version.htm for the details related to architectural / feature set 
changes to the IBackup application (accounts created prior to 10th August 2011.) 
 
 

Link for Application Download 
 
To download the application, go to http://www.ibackup.com/ibackup-for-mac/index.html and click 
the ‘Download’ icon.  
 
The following screen is displayed: 

 

 
 
 

http://www.ibackup.com/old-version.htm
http://www.ibackup.com/ibackup-for-mac/index.html
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Install IBackup for Mac 
 
Follow the steps given below to install the application: 
 

1. After downloading the application, double-click the IBackupforMac.dmg and then click the 
IBackupforMac.pkg. The ‘Welcome to the IBackup for Mac Installer’ screen is displayed.  

2. Click Continue to proceed with the installation. The ‘Software License Agreement’ screen 
is displayed. 

3. Click Continue and Agree from the subsequent screen to proceed. 
4. Select the location where you want to install the application, using Change Installation 

Location and click Install.  
5. A screen is displayed for verification. Enter the valid system password (administrator 

password) and click OK. 
 

On successful installation, a ‘Installation Succeeded’ message is displayed. 
 

 
Login to IBackup for Mac Application 
After installation, you can login to the IBackup for Mac application in two ways: 

1. By double-clicking the IBackup for Mac icon on your Desktop 
2. Start > Programs > IBackup for Mac > the Login screen is displayed 
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The Login screen contains the following options: 

Username or Email address: Enter the 'Username' or 'Email address' provided while registering 
for your IBackup account. 

Password: Enter the password provided while registering for the account. 

Reconnect automatically on login: The application will automatically reconnect on login. 

SSL Encryption: Provides secure transmission of data using the 128-bit Secured Socket Layer 
encryption technology. Note: Data is secured using 256-bit AES encryption during transfer for 
users, who have registered for an IBackup account after 10 August 2011. 

Remember Username/Email address and Password: Saves the 'Username' and 'Password'. 
This option is selected by default and can be changed. 

Settings: Specify the proxy server settings and provide proxy authentication. 

Login: Logs you into the application. 

Cancel: Closes the ‘Login’ screen. 

New user sign up: Sign up for an account from the IBackup website. 

Forgot password: Retrieve your password, which is mailed to your email address provided during 
registration. 

Upgrade Account: Purchase more storage space. 

Firewall guidance: Obtain information on the port number, IP address and executable files that 
require firewall access. 

Logging out 
 
From the application menu bar, go to File and select the Disconnect option, to log out from the 
application. 
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Encryption 
All your data is secured using 256-bit AES encryption during transmission and on storage. IBackup 
for Mac enforces a user specific encryption key to encrypt and decrypt data thereby ensuring data 
is safe and secure. All your data resides on raid-protected devices for additional protection and for 
fast recovery in case of hardware/software failures. 
 
 

 
 
While logging into your IBackup for Mac account for the first time you will be prompted to opt, for 
either a ‘Private Encryption Key’ or ‘Default Encryption Key'. If you opt for the default encryption 
key, an encryption key is set by default to encrypt all your data.   
  
The following screen is displayed on login, if you opt for a private encryption key during registration. 
Enter the same private encryption key and click 'OK' button for authentication. This screen is not 
displayed, if you have opted for a default encryption key during registration.  
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Settings 
Using the Settings option in the Login screen, you can configure the proxy settings and proxy user 
authentication. 

 

Click 'Save Settings' to save the information entered in the screen and 'Cancel' to exit the screen. 
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Proxy Settings 
 
Select 'Enable Proxy Settings’ from the check box to set the proxy settings of the computer. In the 
'Proxy Address' field, enter the IP Address of the computer, where the proxy server has been 
installed. In the 'Proxy Port' field, enter the port number of the proxy server. 
 
For the local area network, if a connection has been made through a proxy in the system 
preferences, then on clicking the 'Get Proxy Settings' button, the proxy information (the IP and the 
port number) will be taken automatically. 
 
'Enable Proxy authentication' grants access to the Internet after valid authentication. The 
authentication information - 'Proxy Username' and 'Proxy Password' must be same as that of 
Username and Password of the proxy server. 
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IBackup for Mac Interface 
 
IBackup for Mac has a simple and user friendly interface, making it easy to browse through the application. On 
a first time login to an account , the following screen is displayed. 
 

 
 
 
The screen has the following options:  
 
Edit my Backup set takes you to the IBackup for Mac main screen from where you can update the 
'Contents of my Backup set' and schedule backups. 
 
Edit schedule parameters opens the 'Scheduler' screen from where you can modify the 
scheduled backup options like day and time and set notification options and so on.  
 
The Close button closes the above screen and displays the main screen of the IBackup for Mac 
application 
 
By default, the IBackup application backs up the 'Documents', 'Desktop', 'Downloads', ‘Library’ etc, 
with the frequency set to a random off-peak hour. You can edit the 'Contents of my Backup set' 
and/or schedule the backup as per your convenience. 
 
The main screen of the application is displayed, as shown below: 
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The screen has three panes: 
 

• The left-side pane shows the files/folders present on your Mac (My Files). 
• The right-side pane shows the files/folders present in your IBackup for Mac account (My 

IBackup). 
• The lower pane shows the files/folders selected for backup (Default Backup Set). 
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IBackup for Mac Menu bar Options 
 
The Application menu bar has the following options: 
 

• IBackup for Mac 
• File 
• View 
• Window 
• Help 

 
 
IBackup for Mac 
 
The IBackup for Mac menu has options that let you update the preferences settings and view 
information about the application. These include: 
 
About IBackup for Mac  
 
Displays information about the application installed on your computer. 
 
Go to IBackup for Mac and select the About IBackup for Mac option from the application menu 
bar to view the version and the date of release of IBackup for Mac application installed on your 
system. 
 
 
Preferences 
 
Go to IBackup for Mac and select the Preferences option from the application menu bar or click 
the Preferences option from the toolbar. 

 
The ‘Preferences’ screen has the following options: 
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Multiple Mac Backup 
 
By default, IBackup for Mac creates a unique folder with the name of the computer to backup data 
from multiple computers into a single IBackup for Mac account. This prevents data overlap during 
multiple computer backup. 
 
Select any of the mentioned options to backup data:  
 
1. Create a folder with the machine name: This option enables you to backup your data to a 
folder that retains the same name as that of your computer  
 
2. Select from the existing machine(s) list: This option enables you to select an existing machine 
name from the machine list for future backups 
 
3. Enter a name of your choice: This option enables you to enter any folder name of your choice  
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You can change the name of the folder for Multiple Mac backup on the ‘Preferences’ screen with 
the help of the ‘Multiple Mac backup settings’ option. 
 
 
Desktop notification 
 
This option lets you receive notification on the desktop on completion of every scheduled backup. 
Follow the steps given below to enable this option: 
 

1. Go to IBackup for Mac and select the Preferences option from the application menu bar. 
The 'Preferences' screen is displayed.  

2. Select the Desktop notification check box. 
 
Automatic Sync 
 
Select this option to sync files between your Mac and IBackup for Mac account with a lag of 30-
days (applicable only for schedule backups). In other words, if data is deleted from your Mac that 
has already been backed up previously, the corresponding data in your online account would be 
deleted after 30-days. This helps in keeping your account size at optimal levels. As a precautionary 
measure, in case the files to be deleted are greater than 5% of the total account content, you would 
have to run a manual sync. * 
 
Note: Automatic Sync may result in automatic deletion of data from your IBackup for Mac account, 
use/set this option carefully.  
 
* The percentage mention refers to files considered for deletion in your account as a percentage of 
total number of files. The purpose of this percentage-based control is to avoid large deletion of files 
in your account due to some unforeseen event on your Mac. 
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Connect automatically after Reboot/ Login 
 
This option automatically connects you to the application, once you log into your Mac. While 
connecting to your account, 'Login' screen is not displayed. 
Follow the steps given below to enable this option: 
 

1. Go to IBackup for Mac and select the Preferences option from the application menu bar. 
The 'Preferences' screen is displayed.  

2. Select the Connect Automatically on Reboot/ Login check box. 
 
Note: This is applicable only if the 'Remember Username/Email address and Password' option is 
enabled on the 'Login' screen. 
 
Automatic power off after the completion of the scheduled job 
 
Selecting this option shuts down the system automatically on completion of the scheduled backup. 
Follow the steps given below to enable this option: 
 

1. Go to IBackup for Mac and select the Preferences option from the application menu bar. 
The ‘Preferences’ screen is displayed.  

2. Select the Automatic power off after completion of the Scheduled jobs check box. 
 
 
Cut off time for scheduled job 
 
This option stops the scheduled backup at the specific time, set by you. The backup is resumed at 
the next scheduled time from the point it was stopped. This ensures that the scheduled backup 
does not interrupt the normal computer operations. 
 
Wake up the computer from Sleep mode during scheduled job 
This option lets the schedule backup take place even if your Mac is in sleep mode. 
 
Start the missed scheduled backup when the computer is turned on 
This option allows the application to automatically resume the scheduled backup when your 
computer is switched on. 
 
Show the progress for scheduled job 
This option lets you display/hide the scheduled backup progress screen. 
 
Alert me if the schedule backup fails 
This option intimates you on the desktop in case your scheduled backup fails. By default, it is set to 
seven days. 
 
Compress data during transmission 
The application compresses and transmits data to ensure quick backup and reduced bandwidth 
usage. This option is enabled by default. 
 
Show hidden files/folders 
This option will display the hidden files/folders in 'My files' and 'My IBackup' panes on the IBackup 
for Mac main window. 
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Auto-Pause 
 
The Auto Pause Option in the Preferences tab makes intelligent guesses on pausing and resuming 
backup to enable optimum desktop experience during user activity. 
 
Bandwidth Throttle (when system is not in use): This option let’s you set the bandwidth to be 
used by your system for backups, when it is not in use. By default, it is set to 100%. 
 
Note: The percentage set for Bandwidth Throttle is applicable for both scheduled and interactive 
backups. 
 
Bandwidth Throttle (when system is in use): Select the 'Auto-Pause' check box to use this 
option.  
 
This option lets you set the bandwidth to be used by your system for backups, when it is in use. 
This allows other applications to run without hindrance. By default, it is set to 25%. 
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Exclude files and folders 
 
The Exclude Tab in the Preferences window allows you to exclude data. To exclude files/folders, 
click the 'plus' icon and use the navigation window to select the files/folders that you wish to 
exclude. 
 
By default, some files and folders including all hidden files and folders are excluded by the IBackup 
for Mac application. To backup excluded items, clear the check boxes and perform the backup 
operation. 
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You can exclude files/folders in the following ways: 
 
Exclude files/folders based on full/partial name 
In the ‘Exclude files/folders based on full/partial name’ box that is displayed, enter the full or partial 
name of the file(s)/folder(s) that you want to exclude from backup. The same exclude parameters 
are displayed in the list box.  
 
You can exclude files and folders on the basis of wildcard characters.  
 
'*' - Represents one or more character(s).  
 
Example: To exclude a folder named 'JAMES', you can enter 'J*'. Here, the '*' replaces or 
represents the remaining characters of the folder 'JAMES'. During backup operation, the IBackup 
for Mac application will search for the folders starting with letter 'J' and exclude them from being 
backed up. 
 
From the main window 
 

1. On the main window of IBackup for Mac application, select a file/folder under ' My Files'  
Right-click and select the 'Exclude files/folders' menu option. 

2. The selected file/folder is added in the exclude list and is visible on the 'Exclude’ screen. 
 
 
File 
 
The File menu has options that let you connect to or disconnect from the IBackup for Mac 
application. These include:  
 
Connect 
 
The Connect option lets you log on to the application. 
For this, follow the steps given below:  
 
 

1. Go to File and select the Connect option from the application menu bar. The ‘Login’ 
screen is displayed. 

2. Enter the Username/Email address and Password and click Login.  
 
Disconnect
 
The Disconnect option lets you logout from your account.  
For this, follow the steps given below: 
 

1. Go to File and select the Disconnect option from the application menu bar. A dialog box 
prompts you to commit your selection. 

2. Click Yes to log out from your account. 
 
Note: The scheduled backup operation continues even after you log out from your account. 
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View 
 
The View menu has options that let you view the details of the transactions of a particular session 
of backup or restore, scheduled backups and all other transactions. These include:  
 
Session Log 
 
Lets you view log details of all the interactive and scheduled backup/restore jobs performed in a 
session. 
 
Go to View and select the Session Log option from the application menu bar to view the list of 
session logs. You can view or delete the selected Session Log by using the View or Delete button 
respectively. 
Interactive Log 
 
Lets you view log details of interactive backup and restore operations.  
 
Go to View and select the Interactive Log option from the application menu bar to view the log 
details of all interactive backup and restore operations.  
 
Scheduled Backup Log 
 
Lets you view the log details of the scheduled backup operations. 
 
Go to View and select the Scheduled Backup Log option from the application menu bar to view 
the log details of the scheduled backup job. 
 
Window 
 
The Window menu has options that let you adjust the size of the application window. 
 
Minimize 
 
This option allows you to minimize the window. 
 
Zoom 
 
This option allows you to adjust the size of the window. 
 
Bring to front 
 
This option allows you to bring a window to the front without bringing all the application's other 
windows to the front. 
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Help 
 
The Help menu has options that let you access the IBackup for Mac help manual, contact technical 
support for any queries related to the application and access the IBackup for Mac website. These 
include:  
 
IBackup for Mac Help 
 
Lets you access the IBackup for Mac help manual. 
 
Go to Help and select IBackup for Mac Help from the application menu bar to open the help 
manual. 
 
Send Error Report 
 
The Send Error Report feature lets you send your queries to the IBackup for Mac technical 
support team, in case you encounter any technical or functional problem while working with 
application. In the mail, classify the type of error or problem encountered so that we can provide a 
prompt solution. 
For this, follow the steps given below: 
 

1. Login to the application. 
2. Go to Help and select Send Error Report from the application menu bar or click the 

IBackup Monitor status item present on the system menu bar and select the Send Error 
Report option. The 'Send Error Report' screen is displayed. 

3. Enter your Username, email address, contact number, trouble ticket number (if any) and 
the subject. 

4. Explain your problem or query in the ‘Message’ text box. 
5. Click the Send button to report your feedback/query to the technical support team. 

 
You will receive an email from the technical support team containing the Ticket Number for your 
query that can be used as a referral, in case you face the same problem again or find that it has not 
been resolved. 
For this purpose, in the ‘Send Error Report’ screen, a text box for Trouble Ticket Number is 
provided. Here, enter the ticket number sent to you.  
 
 
Website 
 
Lets you access the IBackup for Mac website. 
 
 
 
 



 

Copyright © Pro Softnet Corporation. All rights reserved. 23 

Web Based Backup set / Schedule Management  
 
Manage Default Backup set contents online 
 
Login to your IBackup for Mac account via any web browser and click the Manage Backup set icon. 
This opens the Backup Manager screen, from where you can perform the following functions:  
 
Add data to Default Backup set  
 
1. Select the files/folders to be backed up, using the check boxes. 
 
2. Click the 'Update Default Backup set' to update your Backup set.  
 
Schedule a Backup  
 
1. Click the 'Schedule Manager' button. Select the backup day(s), time and notification type among 
other options. 
 
2. Click 'Update Scheduler' to update the scheduled backup details.  
 

  
 
 
View Logs 
 
You can also  view the following logs:  
 
 
 
 



 

Copyright © Pro Softnet Corporation. All rights reserved. 24 

Session Log  
 
Lists the log files created for each of your backup and restore sessions.  
 
Steps to view the Session logs  
 
1. Click the 'View Session Log' button The list of session logs are displayed. 
 
2. Click the specific Session log that you want to view. A 'File download' dialog box is displayed.  
 
3. Click 'Open' to view the log, 'Save' to save the log file on your computer or 'Cancel' to cancel it.  
 
Schedule Log 
 
This option allows you to view the schedule log history of your backup and restore functions 
performed using the IBackup for Mac desktop application. 
 
Steps to view the Schedule logs  
 
1. Click the 'View Schedule Log' button. A 'File download' dialog box is displayed. 
 
2. Click 'Open' to view the log, 'Save' to save the log on your computer or 'Cancel' to cancel it.  
 
Delete data from the Default Backup set 
 
1. In the 'Contents of Default Backup set' section, deselect the files/folders that you wish to remove 
from your Backup Set, using the check boxes provided.  
 
2. Click the 'Update Default Backup set' to update your Backup set. 
 
Note: The Web Management option is enabled by default in the IBackup for Mac application. You 
can disable this option from the IBackup Monitor. 
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IBackup for Mac Toolbar options 
 
The following options are available on toolbar: 
 

• Preferences 
• Scheduler 
• Sync 
• Session Log 

 
Preferences 
 
The Preferences option allows you to customize the settings of the application. On the main 
screen, click the Preferences option from the toolbar.  
 
For more information on the Preferences, see the Preferences section. 
 
Scheduler 
 
The Scheduler toolbar has option that let you edit/delete/stop/refresh or reschedules a backup job 
for an immediate or scheduled backup.  
 
On the main screen, click the Scheduler toolbar option. The 'Manage all the Scheduled jobs' 
screen is displayed, as shown below: 
 

 
 
It has the following options: 
 
Edit: Lets you edit the selected scheduled backup job. You cannot edit a backup job when the 
status indicates ‘In Progress’. 
 
Immediate: Lets you select the scheduled backup job for an immediate backup. 
Refresh: Lets you refresh the backup jobs. 
 
Stop Transfer: Lets you stop the transfer of data to the IBackup for Mac account. 
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Delete: Lets you delete the selected backup job. You cannot delete a backup job when the status 
indicates ‘In Progress’. 
 
 
Reschedule a Backup job using the Scheduler toolbar option 
 
You can reschedule a backup job using the Scheduler toolbar option. Follow the steps given below 
to reschedule a backup job: 
 

1. Login to the application. 
2. Click the Scheduler toolbar option. The 'Manage all the Scheduled jobs’ screen is 

displayed. 
3. Select the scheduled backup job from the list and click Edit to reschedule it. The 'Editing 

the selected record' screen is displayed. 
4. Click Next. The 'Scheduler' screen is displayed.  
5. Set the date and time, frequency of backup, type of notification and click Update. The 

backup is rescheduled and the changes would be reflected on the 'Manage all the 
Scheduled jobs’ screen. 
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Time Machine Backup  
 
IBackup for Mac can now backup Time Machine data to your online account. This is to provide 
additional protection to your Mac, including system files, applications, accounts, preferences, 
music, photos, movies, and documents. You can recover your Mac / data directly by downloading 
the Time Machine folder from your IBackup account. You can also request a drive to be shipped to 
you via our Rapid Serve program containing Time Machine data.  
 
Setting up Time Machine Backup is easy. Simply select the Time Machine backup from the left-
hand pane of the application.  
 

 
 
 
Note: The Time Machine folder in your IBackup account will be in sync with your Time Machine 
data. This means, data removed from your local Time Machine folder will also be removed from the 
online account. This is necessary to maintain the integrity of the Time Machine folder data and to 
insure that the folder size will not grow out of control.  
 



 

Copyright © Pro Softnet Corporation. All rights reserved. 28 

Sync 
 
The 'Sync' feature lets you match the contents of your IBackup for Mac account with that of your 
Mac, for the selected folders. It is useful when you have been taking backups regularly and 
removed some data from your local computer or your account. 
 
To sync data, follow the steps given below: 
 

1. Select the folders to be synchronized on the 'My IBackup' pane and click 'Sync'. 
2. A screen shows the list of the files/folders present in your IBackup for Mac account but not 

on your Mac. 
3. Click the 'Sync' button to remove the files/folders from your IBackup for Mac account to 

match them with your local computer. 
 
 
 

 
 
 
Sync data backed up from Multiple Mac computers 
 
In order to Sync files/folders inside the Multiple Mac folder, follow the below steps: 
 

1. Ensure that 'Multiple Mac Backup' feature is enabled. 
2. Locate the folder in your IBackup account with the same name as the Mac machine. 
3. Select the folders that you want to sync and click the 'Sync' button. 
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Versioning 
Provision to maintain upto 30 previous versions of all the files in your IBackup account on an 
everyday basis. 
 
This implies that in case you had a prior version that was backed up in the last 30 days, you should 
be able recover via the Versioning option. You can see the version of a file that is listed under 
'Version' column on the 'My IBackup' area. The version number increases as you update the file. 
 
 
To check the Version History of any file, follow these steps: 
 

1. Right-click on the desired file and select 'Show Version History'.  
2. The 'File Version' screen is displayed with the list of file versions, modified date and the file 

size.  
3. Select the version to restore the desired file and click 'Restore'.  
4. Select a drive/folder in your local computer to restore. 
5. Click on the 'Restore' button to restore the selected version of a file. 
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Session Log 
 
The Session Log option lets you view log details of all the interactive and scheduled 
backup/restore jobs performed in a session. You can view or delete the selected Session Log 
using the View or Delete button respectively. 
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Other Options 
The application has the following additional options to perform functions like refresh, delete, 
backup, share, recalculate, restore, schedule backups and so on. 
 
 

Image Button Description 

 Refresh  
Lets you refresh the contents of the files on your 
Mac/IBackup for Mac account with the latest 
changes. 

 Delete  Lets you delete the selected files/folders from your 
IBackup for Mac account. 

 Recalculate  Lets you know the amount of space used in your 
IBackup for Mac account. 

 Share Lets you share files/folders from your IBackup Mac 
account. 

 Trash 

 
Lets you retrieve deleted files from your IBackup 
account within a period of 30 days. 
 

 Help  Lets you access the IBackup for Mac help manual. 

 Backup Now  Lets you perform an immediate backup of the 
files/folders. 

 Schedule  Lets you schedule backup of the files/folders for a 
future date and time. 

 Restore  Lets you immediately restore the files/folders from 
your IBackup for Mac account to the local Mac. 
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Working with IBackup for Mac 
 
Interactive Backup  
 
Using the Backup Now button  

 
1. Login to the application.  
2. Select the files/folders from the left pane (My Files) using the check boxes.  
3. Click the Backup Now button to start the backup.  

 
Drag-n-drop 

 
1. Login to the application.  
2. Drag files/folders from the left pane (My Files) or Finder and drop on the right pane (My 

IBackup).  
 
Note: Files and pictures can be dragged-n-dropped for backup, even as you work on them. 
 

 
 

Using IBackup Monitor Status Item  
 
1. Click the IBackup Monitor status item on the system menu bar. 
2. Select the Backup Now option.  

 
This starts an immediate backup for the content of your previously created Backup set. 
Note: Ensure that you have (i). Logged into the application at least once. (ii). Created a Backup set. 
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Schedule Backup 
 
You can schedule the backup of your files/folders using the Schedule Backup button. 
 
In the main screen, click the Schedule Backup button. The ‘Scheduler’ screen is displayed, as 
shown below: 
 

 
 
The following options have to be set to schedule a backup job:  
 
Day, time, and frequency of backup 
 
The options available to set day, time and frequency of backup are as follows: 
 
Daily schedule: On selecting this option, all the days of the week are selected for backup. You can 
deselect the day on which you do not want backup to occur. 
 
Hourly schedule: Select this option to backup your data on an hourly basis. 
 
Start the job immediately: This option lets you to perform an immediate backup of your 
files/folders. 
 
Monthly schedule: Select this option and set the day of the month for your scheduled backup job. 
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Schedule Time: Set the time for your backup jobs. 
 
Cut-Off time: Set the time at which your scheduled backup should stop. 
 
Types of Notification 
 
The options available to set different types of notification are:  
 
Email notification 
 
This option lets you receive email notification on the status of the scheduled backup job. 
 
On choosing the 'Notify always' option, you are notified on your backup status irrespective of its 
failure or success. 
In case you wish to receive this notification only on backup failure, choose the 'Notify on failure' 
option. 

 
Attach log extract 
 
You can opt to receive log details of the scheduled backup job along with the email notification, by 
selecting 'Attach log extract' check box. 
 
Desktop notification 
 
This option lets you receive notification on the desktop regarding the status of the scheduled 
backup job.  
For this, select the Notify to desktop after completion of the scheduled job option.  
 
 
Restore Files and Folders 
 
You can perform an interactive restore of the files/folders in following ways: 
 
Using the Restore button 

1. Login to the application.  
2. Select the files/folders present on the right pane (My IBackup).  
3. Click the Restore button. The 'Where to Restore?' screen is displayed.  
4. Select the destination to which you want to restore the selected files/folders and click 

Restore. 
 
The application checks the status of the files/folders and restores them to the selected destination. 
On successful completion of the restore process, a message to view the restored files is displayed. 
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Drag-n-drop 
 
1. Login to the application.  
2. Drag files/folders from the right pane (My IBackup) and drop on the left pane (My Files) or 

Finder.  
 
Note: If the files/folders selected for restore are already present at the specified location, then they 
are overwritten. 
 
The application checks for the status of the files/folders and then restores them to the selected 
destination. On successful completion of the restore process, a message to view the restored files 
is displayed.  
 
 
Share 

The Share file/folder feature in IBackup for Mac allows you to share data with your associates in the 
following ways for collaborative access.  

Select files/folders and click the 'Share' icon on the tool bar. 
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Alternately, right click on the files/folders you wish to share and from the menu displayed, click on 
the 'Share' option. 
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This takes you to a popup window from where you can set the share parameters and enter the 
email address of the recipient(s). 
 

 
 
Location: Shows the location of shared file / folder in your account 
 
Write Enabled: Permits your associate to modify and upload the shared file / folder to your account 
 
Upload new file: Allows your associate to upload a new file to your account 
 
Image Gallery View: Allows your associate to view all the pictures as thumbnails 
 
Number of Downloads: The number of downloads permitted for your shared file / folder before the 
link expires 
 
Number of days: The duration for which the shared link would be active 
 
Password: Safeguard the shared file / folder by providing a password and sharing the same with 
your associates 
 
Mail Details: Enter the email addresses of the recipient with whom you wish to share the 
files/folders 
 
Note: Share option is limited for IBackup accounts with Default Encryption.  
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Trash 
 
Trash feature helps you recover files that are deleted by accident from your IBackup account. This 
is an added protection for your critical data that may be lost due to unintentional events. By default, 
files deleted using delete command will be moved to Trash. The files in Trash will automatically get 
deleted after a 30 day period. 
 
Note: While deleting a particular file, all its previous versions will be deleted from the IBackup for 
Mac account. 
 
You can restore your deleted files to the desired location in your IBackup account or any location in 
your local computer. Option is also available to delete files from Trash permanently. 
To manage your files in trash, click on the 'Trash' icon in IBackup for Mac interface. The deleted 
files are listed out. In the 'Trash Search' option that is displayed, provide the full / partial file name to 
locate the same. 
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To restore files from the Trash, follow these steps:  
 

1. Click 'Trash' icon on the toolbar. The files available in Trash are listed. 
 

 
 
 

2. Select the check box to restore / move the desired files from Trash.  
 

3. Click the 'Put Back' button to move files to the original location in your IBackup account or 
click ‘Restore' to restore files to the desired location in your local computer. 
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To view files deleted from a specific folder in the IBackup account: 
 
Right-click on the desired file in Trash and select the ‘Show Version History’ option. Select the 
required version and click on ‘Restore’. 
 
 
Click ‘Delete Forever’ to delete the files permanently from Trash, if it is no longer required. To clear 
all the files in Trash, click ‘Empty Trash’. 
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Search 
 
You can locate files backed up to your IBackup for Mac account and restore them to your local 
machine. 
 
For this, follow the steps given below: 
 

1. Connect to the application. 
2. Enter the file/folder name in the search field on top right hand side of the main screen and 

press 'Enter'.  
3. The 'File Search' screen is displayed, as shown below: 
 

 

 
 
All the files matching the search criteria are displayed. 
 
From the search result, select the desired file and click 'Restore' to restore it to your local machine 
or 'Delete' to delete it from your IBackup account.  
You can filter the search by selecting any of the following options: 
 

• Match the whole file name 
• Picture, Music and Video Files 
• Document Files (.doc and .txt) 
• All files 
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IBackup Monitor Status Item 
 
On installing the application, an IBackup Monitor status item is displayed on the system menu bar 
of your Mac.  
 
On clicking the IBackup Monitor status item, a menu is displayed, as shown below: 
 

 
 
This menu has the following options: 
 
Software Update 
 
This option allows you to upgrade to the latest version of the IBackup for Mac application. 
 
Launch IBackup for Mac 
 
This option opens the IBackup for Mac application. 
 
Backup Now 
 
This option lets you perform an immediate backup of the scheduled backup job without logging into 
the application. For this, click the IBackup Monitor status item present on the system menu bar 
and select the Backup Now option. 
 
Note: Ensure that you have (i) logged into the application at least once before and (ii) created a 
Backup set. 
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Show Progress 
 
This option lets you view the progress screen of the scheduled job, which is in-progress. For this, 
click IBackup Monitor status item present on the system menu bar and select the Show Progress 
option. 
 
Manage all the Scheduled jobs 
 
This option makes it easy for you to manage all the scheduled backup jobs by letting you delete the 
scheduled backup jobs of the expired accounts while retaining the scheduled jobs of the others. 
To manage the scheduled jobs, click the IBackup Monitor status item and select the Manage all 
the Scheduled Jobs option.  
 
The 'Manage all the Scheduled jobs' screen is displayed, as shown below: 
 

 
 
It has the following options: 
 
Edit: Lets you edit the selected scheduled job. You cannot edit the scheduled job when the status 
indicates ‘In-Progress’. 
Immediate: Performs immediate backup of the scheduled job.  
Refresh: Refreshes the scheduled list of records.  
Stop Transfer: Stops the progress of the selected scheduled job. 
Delete: Deletes the selected scheduled job. You cannot delete the scheduled job when the status 
indicates ‘In-Progress’. 
 
 
View Log 
 
This option lets you view the log details of all the interactive and scheduled jobs performed in a 
session. 
For this, click the IBackup Monitor status item present on the system menu bar and select the 
View Log option. 
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IBackup for Mac Help 
 
Provides access to the IBackup for Mac help manual. 
 
 
Send Error Report 
 
This option lets you contact IBackup for Mac technical support team for queries, suggestions or 
provide feedback.  
For this, follow the steps given below: 
Click the IBackup Monitor status item present on the system menu bar and select Send Error 
Report.  
 

1. Enter your Username, email address, contact number, trouble ticket number (if any) and 
the subject. 

2. Explain your problem or query in the ‘Message’ text box. 
3. Click the Send button to report your feedback/query to the technical support team. 

 
 
Quit IBackup Monitor 
 
This option would close the IBackup Monitor. 
 
Uninstall IBackup for Mac Application 
 
Follow the steps given below to uninstall the application: 
 

1. Go to File > New Finder Window > Application > IBackup for Mac and double-click the 
IBackupUninstaller.app. The ‘Welcome to IBackup for Mac Uninstaller’ screen is 
displayed. 

2. Click Continue to proceed and click Yes from the subsequent screen to confirm the 
uninstallation. 

3. A screen is displayed for verification. Enter the valid system password (administrator 
password) and click OK. 

 
On successful uninstallation, the 'Successfully uninstalled IBackup for Mac’ message is displayed. 
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System Requirements 
 

• Mac OS X 10.4 Tiger or later 
• 500MHz G3 processor or later 
• 256 MB RAM 

 
Technical Support 
 
IBackup for Mac Product Support office, 
Pro-Softnet Corporation,  
IBackup for Mac Division,  
26115 Mureau Road, Suite A, 
Calabasas, CA 91302. 
 
Telephone: 
1-800-949-3555 ext 3 within USA 
1-818-251-4200 ext 3 outside USA 
Monday - Friday, 6:00 AM to 6:00 PM PST 
 
Fax: 
1-818-878-9208 
 
Email: 
support@ibackup.com
For more information visit: http://www.ibackup.com/ibackup-for-mac/
 

mailto:support@ibackup.com
http://www.ibackup.com/ibackup-for-mac/
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